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In this course, you‟re going to be building many, many different spreadsheet models. We‟re 

going to be using the program Microsoft Excel, version 2007.  If you do not have 2007 and have 

previous versions of Excel, just keep in mind that most of the things that you can do in 2007, 

you can also do in older versions.  It‟s just that the interface looks a bit different.  If you‟re using 

Microsoft Excel 2007 for the first time, you‟ll have no problem getting used to how the 

spreadsheet is organized. If you don‟t have Excel, you can use the OpenOffice version of a 

spreadsheet, which is called CALC, C-A-L-C, and that is freely available if you google 

OpenOffice.org.  

 

The goal of this exercise is to just introduce you to the Excel interface and to also get you using 

many of the functions that we‟ll be using throughout the course. When you open up your new 

version of Excel or open up and launch the program itself, you‟ll see that three sheets are 

displayed.  Each of these areas is called a sheet, and you can click on those to bring you to a 

new sheet.  And if you double-click on them, you can start to type in the name of a new sheet. 

So let‟s call this „Introduction to Excel‟. 

 

Now what you see when you open up the spreadsheet is the Office button, which is located in 

the upper left-hand corner, the mini toolbar, which is just to the right of that, and then you‟ll see 

what‟s called the ribbon.  And we‟re going to go through each of these, in turn, just to get you 

oriented with how the program works.  

 

Let‟s start with the Office button.  When you click on the Office button, you‟ll see that there are 

options to open a new workbook, create a new workbook, open an existing file, save your file, 

save it as a different particular name, print, prepare some documentation for the file, email the 

file, publish it and close it.  

 

There‟s also a button at the bottom labeled Excel Options. If you click on that, you‟ll see that 

there are many different tabs here. The first page shows you the most popular options, for 

example:  Show the mini toolbar, Enable Live Preview, Show the Developer tab, which we‟ll 

click a little bit later, and then different types of default options.  And you can change these as 

you‟d like.  
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If you move to the Formulas page, you can set how the worksheet is calculated and a whole 

bunch of other things.  Proofing is another option.  You have your Save options when you press 

this.  And then you can also have some Advanced options.  Don‟t forget that you can use the 

scroll bar and make sure you can see all of the different options that you can use.  For the most 

part, you can go ahead and keep most of these options set at the default setting.  And if we‟re 

going to change anything, we‟ll go ahead and have you change them as we‟re working through 

a particular exercise.  

 

There‟s one option that I‟d like you to choose right now, though, and that is the Add-Ins page. 

When you click on this, this lists all of the add-ins. These are little programs that run in Microsoft 

Excel that are designed to do a particular thing.  If you want to manage the add-ins, you go 

down to the very bottom and click on the button that‟s labeled „Go‟.  

 

Here are the available add-ins throughout this particular course. The one add-in that you need 

to have is called the Solver Add-in, and you want to have that be selected.  And then press 

OK, and that would add Solver up to your ribbon.  And we‟ll cover that a little bit later, actually, 

in future exercises. If you don‟t have the option to add in the Solver Add-in, then you need to 

contact, or get the CDs, or contact somebody who can help you so that that particular add-in 

can be installed.  

 

That is called the Microsoft Office Button. The next part that we want to cover is called the 

Microsoft Office mini toolbar. If you click on this, there‟s a little drop-down that says 

Customize Quick Access Toolbar.  I call it the mini toolbar.  These are the buttons that are 

displayed. There‟s the Save button.  There‟s the Undo and Redo buttons.  You can add into this 

mini toolbar any of the buttons that you really like and you find that you use over and over and 

over again.  

 

If you really dislike the Microsoft Office 2007 version, you can actually re-create the 2003 

interface using this Quick Access Toolbar and not use the ribbon at all. So we‟re going to add 

some things here a little bit later, but for now, let‟s just keep moving on through the program.  

 

This section right here is called the ribbon. The ribbon contains these different tabs.  There‟s the 

Home tab, the Insert tab, Page Layout tab, Formulas, Data, Review, and View.  On each of 

these different tabs are a number of different options that you can select. The idea behind the 

ribbon is that commonly-used commands are grouped together. So if you click on a particular 

tab, like Formulas, then all of the commands that relate to formulas are found on this page.  
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These formulas are grouped into little boxes called „groups‟.  So here‟s a group called the 

Function Library.  Here‟s another group called Defined Names and another group called 

Formula Auditing. 

 

Let‟s click on the Home tab.  And the Home tab is meant to contain all of the very most 

frequently used commands that people use when doing spreadsheet work. These areas here - 

you can see here‟s a group called „Alignment‟.  And if you see the little drop-down arrow, that 

means if you click on that, a dialog box will present itself which will give you more options to 

pursue.  I‟m going to push Cancel. 

 

We‟re going to be using many, many different formulas and functions and these kinds of formats 

as possible in this exercise. If it‟s a bit overwhelming, don‟t worry.  You‟re going to have an 

opportunity to create this at your own pace and your own speed.  The goal of this exercise is 

just to acquaint you with some of the options and functions that are available within the 

spreadsheet.  

 

Spreadsheets are set up in columns and rows. Columns are lettered, and rows are numbered. 

This box right here is the „formula bar‟.  This is a place where you can enter a formula, and it 

tells you what cell is actively selected.  I‟m going to click on cell B1, and you can see the name 

B1 appears in the Name Box.  I also know that cell B1 has been selected because the column 

B, and the row 1 have both been turned orange to indicate that is the active cell.  

 

I have always felt that the best way to learn something is to just go right ahead and move right 

into it and learn as you go.  What we‟re going to do in this particular exercise is we‟re going to 

set up a population of individuals that are birds.  And these birds are all going to have beak 

sizes of a particular length.  We‟re going to let birds with a particular beak size be survivors, and 

we‟re going to let those that don‟t have that particular size be killed off in some kind of an event. 

This is prefaced based on one of my all-time favorite books called The Beak of the Finch by 

Jonathan Weiner.  

 

Let‟s start by selecting cell A4, and we‟re going to type the word “Individual.” As you type a text 

reference in a particular cell, if it is larger, if the text itself is larger than the cell width, it will spill 

over into the neighboring cell.  As you can see here, the word Individual has spilled over into 

column B, just a bit.  If I want to change that, I can go up with my mouse, wait until the cursor 

changes to a crosshair, and then double-click, and that will automatically re-size my column to 

match the width of the text that is entered in those particular cells.  
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Now what we‟re going to do is set up a population of 25 individuals, and I‟m going to show you a 

couple of different ways to do that.  First, you can start by entering the number 1.  And we‟re 

going to copy and make our population extend down to row 29 by grabbing on the right corner 

of that particular box until it turns into a crosshair.  And then I‟m using my mouse, and I‟m right-

clicking on that, and I‟m going to drag it down.  And when I release it, I have an opportunity to 

click Fill Series, and that will fill in a particular series of numbers through the reference that I had 

selected.  So that‟s one way to do that.  

 

A second way to do that is to simply start the series by entering the number 1 in cell A5 and the 

number 2 in cell A6 and then selecting both cells and then grabbing the bottom right corner and 

dragging this down until you find the number of individuals that you want, 25.  

 

Just so we can see all 25 individuals, I‟m going to shrink and zoom out, a little bit.  And then I 

might want to re-size my column again.  Again, by double-clicking on the right edge of that 

column heading.  

 

The third way you can do this - and this is the way I‟m going to set it up right now - is to use a 

formula.  And in this case, we want to just add the number 1 to the previous cell.  And so this is 

the simplest kind of formula.  We select cell A6, and we can just begin by just typing “=” and 

then I can use my mouse to select cell A1 and then add the number 1 to it.  And that is my 

formula.  It‟s reflected up in the formula bar, and this is where I can edit that formula.  

 

If I press the Enter key, then the entry will stick. If I‟ve made a mistake and want to start all over, 

I can simply press the Cancel button. I‟m going to go ahead and press the Enter button, and 

you‟ll see - that the formula - that this cell doesn‟t have an entry now.  Instead, it is displaying 

the results of this particular formula.  

 

Now what does this formula mean?  This formula means what I want to appear in cell A6 is 

whatever value is in cell A5, and I‟m going to add the number 1 to it.  So if I make the number in 

cell A5 - be 7, then cell A6 is automatically updated.  

 

We‟re going to start our individuals with the number 1 and drag them down.  If I want to fill out to 

25 individuals, I can simply take this cell and copy it.  And I‟m going to go ahead and use the 

commands on the Home Clipboard just so you get used to that.  So here‟s the Copy command 

button.  And I‟m going to select cell A7, and I‟m going to paste it.  And when you click Paste, 

there are usually several different options.  And throughout the course, you‟re going to be using 

different options, but for this particular case, we just need to paste that value in.  
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Now these little squiggle lines here are affectionately called marching ants.  And if you are 

bothered by them, you can simply hit the Escape key, and that will send them off on their way.  

 

Now let‟s click on cell A7.  And what is the formula there?  I took the value in cell A6, which had 

this formula, A5+1, and I copied it into cell A7.  But now the formula has automatically changed 

to A6+1. And this is what‟s known as a „relative reference‟.  And this is something that we‟ll have 

to really pay close attention to in any kind of spreadsheet model that you do. So what that 

means is when I clicked on cell A6, and I entered “Is equal to A5+1,” what I really was entering 

is „Take the cell directly above it and add the number 1 to it.‟  And when I copied that formula 

down, now in cell A7, the formula still reads,‟Take the cell directly above it and add the number 

1 to it.‟  So that‟s how you know whether a reference is relative or not.  It‟s not really referring to 

a particular cell.  It‟s referring to the relative position around that cell that‟s used in the formula. 

 

Now I can take that formula, go to the bottom where it turns into a crosshair. This is called the 

„Fill Handle‟.  And I can pull this down to cell A29 and have my 25 individuals displayed.  

 

Now that I have my 25 individuals, let‟s give each of those individuals a beak size.  So click on 

cell B4 and enter the words „Beak Size.‟  And, again, if you want to auto-size that, go to the top, 

select column B, go to the right side and double-click.  

 

And here, we‟re going to create a list of beak sizes for each and every individual in our 

population. And we‟re going to use a random number to do this.  The random number is one of 

the very simplest functions that you can use in this spreadsheet, and we‟ll use this a lot 

throughout the course.  

 

Now to enter a function, you‟d go up to the function - the Insert Function command.  And when 

you click on that, it brings up a dialog box, and there are lots of ways that you can find a 

particular function.  And, in fact, there are lots and lots of different functions that you can use. 

We‟re really only going to be using some of the most common ones for this class.  

 

Here, if you know what you want to do, but you don‟t know the name of the function, you can 

type a brief description, and Excel will try to find something that might match or meet your 

needs.  You can select a category of functions.  This is selected the Most Recently Used. If you 

choose the drop-down box, and you know you want to use, say, a Financial formula, or a Date & 

Time formula, or a Math & Trig formula, you can find those, and then Excel will display those 

formulas of those types in the box below.  Right now, the Most Recently Used formulas are 
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selected, and so this is displaying some of the formulas that I have used in the most recent 

cases when doing spreadsheets. Your list might look different than mine, and that‟s fine.  

 

So let‟s go ahead and try, first, typing in “random number” because that‟s what we want.  We 

want Excel to find a random number and then press Go.  And it gives us several different 

options here, and the one that we want is just “random number.”  If you click on these, you‟ll see 

that Excel tells you what that particular function does.  When we click on R-A-N-D, it returns a 

random number greater than or equal to zero and less than one, evenly distributed, and it 

changes on re-calculation. That‟s the formula that we want, so we press OK.  In this particular 

formula, it says, “This function takes no arguments.” And I‟ll explain that in just a couple of 

minutes.  We‟ll use a different kind of formula that does contain arguments. This is all that that 

formula does.  

 

Every formula begins with the name of the formula, and then two parentheses.  And inside 

those parentheses are what are called arguments, things that feed into the formula that produce 

a result.  In this particular case, there are no arguments, and so all we need to do is press OK, 

and Excel generates a random number between zero and one.  

 

Now let‟s take a look at what the formatting is of this particular number.  Up in my Home tab, I 

can see that this particular cell has a General format.  And if I wanted to change how that 

particular format is displayed - and let‟s say I only want to do display two decimals - I can click 

on the Decrease Decimal command and show only two decimal points.  Let‟s click on that 

again.  And what is done is it‟s changed that to a number format.  

 

Now if I want to copy this formula down, I just select cell B5, go to the bottom right corner of 

that, find the Fill Handle, where it changes to a crosshair, click on that, and drag and hold the 

mouse key down, and pull that formula all the way down through my 25 individuals.  And now 

each of my individuals has a beak size; granted, these are pretty small birds.  And so what we 

might want to do is change this random number and multiply that by 10.  And so now I‟m going 

to be editing this particular formula.  

 

Let me do that again. I click on the cell, and then I go up into the formula bar, and I click on it. 

And now I‟m in edit mode, and I can just enter the Times key and add the number 10.  And now 

my formula says, “Equals a random number times 10,” press the Enter button, and now I have a 

beak size.  And now I can copy this all the way down through the remaining 25 individuals of the 

population. 
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Now let me tell you a quick trick for how to copy an equation or formula down through a series. 

Now that I‟ve entered my formula in cell B5, I can go to the Fill handle, and instead of dragging it 

down, I can simply double-click rapidly, and it will automatically fill it down until the last cell in 

which there is an entry.  So let‟s go ahead and do that.  Okay?  That makes it a lot easier for 

you to fill in numbers down a column, especially when you have a lot of numbers to deal with.  

 

Okay, now you have 25 individuals and they each have a beak size.  And your formula should 

read random number x 10, RAND()*10.  And we‟ll double-click that all the way through and that 

gives us beak sizes between 0 and 10. And now the next step is to assign a sex to each one of 

these different individuals.  So lets go ahead in cell C4 and enter the word Sex.  And what we 

will do before we enter a formula down here is we‟ll create a little space spreadsheet that is set 

up for some inputs.  So in cell F1, lets type the word Inputs, and these inputs are going to 

stretch across cells F1 and G1.  So select those with your mouse and then go up to the Merge 

and Center command, and then go ahead and make that bold. 

 

So our first input here is going to be a sex ratio, and so we‟ll enter the word Sex Ratio.  And 

that‟s the ratio of males to females.  And remember we can stretch this column over a bit by 

dragging the corner of the column itself.  And this will be an input that we‟ll start with.  And so by 

convention we will shade our inputs with the color green.  So choose a color green as well as a 

border – green for go into the model.  And lets start with a sex ratio of 0.5.  So that the ratio of 

males to females is 0.5.  

 

So now given this information we can enter a formula in cell C5 that will reference this sex ratio. 

And it will assign – it will use a random number and if that random number is less than the value 

here, we‟ll let that value be a male and if it‟s greater we‟ll let that individual be a female.   

 

Okay?  So the formula is going to be an IF function.  And we can reference this by clicking on 

the Insert Function command.  And then finding the IF - and this is a very common formula, IF.  

And if you don‟t know where to find it you can enter that again in the search for function.  You 

can also do it alphabetically, if you choose All, and list them and start typing IF and it will drop  

you right down to the IF function. 

 

Now this IF function has three arguments.  And the first argument is called the „Logical Test‟.  

And so we need to state something that can be logically evaluated as true or false.  So lets go 

ahead and make our logical test be, „Is a random number less than the value in cell G2, 

rand()<G2.  So that is our logical test.  The random number is less than G2, and we need to 

anchor that G2 by pressing the F4 key on a Windows based machine.  So that‟s our logical test. 
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Is a random number less than the value in cell G2?  If it is, than lets record that that is a male.  

So the value if this is true, we will enter an „M‟ for male.  And if it‟s not – if that same random 

number is greater than the value in the cell G2, we‟re going to let that be a female.  And we‟ll 

enter that with a capital „F‟.  Now these need to be in quotes, because they are not numbers, 

they are characters and so they need to be represented in quotation marks. 

 

So this random number is volatile, meaning it changes every time you press the F9 key or 

recalculate key.  So in this particular formula we don‟t know what the actual random number is,  

we are telling Excel to draw a random number between zero and one, and then perform this 

logical test.  After it performs a logical test - then if that logical test is true, the capital M is 

returned and if false a capital F is returned. 

 

And when we are finished with this, we just press OK.  And we can see that the first individual is 

a male.  And again we can use this double-click trick in the corner of the box here, and click all 

the way through to assign a sex to each of our individuals. 

 

Okay, now notice that the beak size in this example is not tied to the sex of an animal.  And in 

some cases we know that males and females have different body sizes, and so you may want 

to some how link these two cells together.  However, we‟re going to just assign a random sex to 

each individual. 

 

In column D we‟re going to indicate whether these individuals survived or not.  And so what we 

will do here, in cell D4, is enter the word „Survive‟.  And we‟re going to let the number 1 indicate 

that an animal has survived a draught and we‟ll let a 0 indicate that the animal has not survived 

a draught.  And this scenario is based off of one of my all time favorite books called, „The Beak 

of the Finch‟, by Johnathan Weiner - and if you haven‟t read it, it‟s a great read.  And so it‟s the 

story of one of Darwin‟s finches and the factors that affect their evolution. 

 

So up here in the inputs, in cell F3, lets choose through natural selection.  We‟re going to let 

animals that have a greater beak size that is greater than some value - which we will enter into 

cell G3 - we‟ll let those animals survive.  So this will be a model input.  So lets go ahead and 

shade that green and give it a border.  And lets, just for the sake of a scenario, lets choose 

animals that have a beak size greater than 5, as animals that will actually survive. 

 

So now, we need to enter an equation in cell D5 that will look at this individuals beak size, 

compare it to the beak size that‟s given in cell G3 and return the number 1 if it survives and the 

number 0 if it does not survive. 
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What formula would you use? 

 

Right, it‟s going to be another IF function.  So lets go back up and choose the insert function 

and find the IF function once again.  And this time our logical test is going to be - we‟re dealing 

right now - we‟re going to enter the equation for individual one.  So is this individuals beak size 

greater than the value in cell G3.  And we need to anchor that G3 because we‟re always going 

to be referencing that cell as part of our logical test.   

 

So we‟re choosing animals that have beaks greater than 5 units.  And so if that number is true 

we‟ll let them survive.  And we will indicate that with a number 1 and if that number is false we‟ll 

enter a 0, because that animal has died.  And when we‟re finished we‟ll press the OK button. 

And then we can just copy this formula all the way down or double-click and the formula will be 

filled down for us.    

 

Now let‟s take one more step back, and we‟re going to look at the formula again in cell D5. And 

what we‟re referencing here is cell G3.  And oftentimes - one thing that Tony [Starfield] will 

stress throughout the course - is that it‟s helpful to think of equations as word equations.  You 

know, logical thoughts and a logical stream of arguments that you want to express 

mathematically.  

 

And so one way of doing that and aiding that process is to give cells a particular name.  And if I 

wanted to name a cell, I can click, for example, on cell G3, and I can name that cell something 

like Survival Threshold, and there‟s a couple of ways that I can do this.  The easiest way is to 

click on the cell, and then go over into this area, which is called the Name Box, select it, and 

then just start typing in the name that you‟d like.  So I‟m going to call this Survival Threshold. 

And in this particular box, there cannot be any spaces between - any blank spaces.  And so if 

you need to have a space maintained, use an underscore key.  And when you‟re finished, press 

Enter.  And now when I click on that cell, instead of G3 appearing up here in the Name Box, the 

actual name of the cell is revealed.  

 

Now I‟m going to go ahead and re-write the equation in cell D5.  So I‟m going to delete that, and 

I‟m going to use an If function again, just to show you how it works. This was a function I just 

used. So find the If function.  And my logical test is going to be the same.  If Individual one‟s 

beak size is greater than cell G3 - but now, instead of G3 appearing, the actual name of the cell 

has appeared.  Value if true is 1, Value if false is 0.  
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Now when a cell is named, by default, it has an absolute reference.  And so if I press OK and 

copy that down, my formula will still be maintained.  No matter how I look at it, I‟m referencing 

the survival threshold value.  

 

Now the very, very nice thing about spreadsheets is as you change these inputs, your 

spreadsheet will automatically be updated. So, for example, if I decided that I wanted to have a 

population of all males,  I can enter the number 1 in cell G2, and all of the individuals will be 

males.  If I wanted to have a population of all females, I can enter the number 0 there, and my 

spreadsheet‟s automatically updated. If I wanted to change my survival criteria or my survival 

threshold, I can simply change that number, and all of these formulas are automatically 

updated.  And that is why spreadsheets are a good modeling tool. 

 

Let‟s go ahead and change these back to 5 and a sex ratio of .6.  

 

Another really handy thing to do, especially when you‟re spreadsheet modeling, or actually 

when you‟re just looking at data, in general, is to select some cells and apply some conditional 

formatting.  And that will help us to really see, quickly, which species or which individuals are 

going to survive and which will die.  And we can do that by selecting those cells and then going 

to the Home tab, and then going over and selecting the Conditional Formatting button. 

 

Okay, if you click on the drop-down arrow, you‟ll see several different options.   And we‟re going 

to use this one called Highlight Cell Rules.  But there are other options as well, and one I 

wanted to just point out to you is this one called Data Bars. And if you move over and choose 

one of those, and now look at column B, you‟ll see that those cells are shaded relative to their 

values from one another. So the bird with the largest beak has the largest-scale shading, and 

the birds with the smallest beaks are shaded hardly at all. This is a quick way for you to get a 

good handle, a good visual representation of the data itself.  

 

As much as I like this option in Excel, we‟re going to use a different kind of conditional 

formatting.  And we‟re going to select those cells and then go up to the Conditional Formatting 

tab and then highlight Cell Rules.  And we‟re going to invoke a new cell rule, and we‟re going to 

say, “If cells are greater than,” and a dialog box appears, and instead of entering a number 

here, we‟re going to collapse this dialog box and go and choose the survival threshold in cell 

G3, expand the dialog box, and then choose what color you want to highlight them with. Okay. 

This, by default, is light-red fill with dark-red text, but there are many other options you can 

choose from as well.  
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So now we have - well, we actually have both of these things invoked.  We have cells and 

animals that have beak sizes greater than the threshold are shaded as a red.  And, as we 

expect, those animals will survive.  And we also have our formatting that tells the indication of 

how big or how large the numbers are, and set up as a conditional formatting as well.  

 

I‟m going to go ahead and take that one off.  To do that, I‟m going down to Manage Rules, and 

if I click on that, I can see I have two rules here that have been applied. The first one, if the cell 

value is greater than the cell in G3, here‟s the formatting that is applied.  And then we applied 

the Data Bar Rule.  And in this particular case, we want to delete that one.  And so we click on 

that particular option, and then go up to the Delete Rule button and delete it, and then press OK. 

 

Another kind of formatting that is handy is the ability to format a group of cells as a table.  And 

this is another way of cleaning up your entries.  And what we‟re going to do is select all of our 

data now, from cell A4 all the way down to D29.  And we‟re going to click on the Home tab, and 

then head over toward the right-hand side and find, in the styles group, Format as Table.  And 

if we click on that, you‟ll see a whole bunch of different styles pop up.  And what these will do -

choosing one of these options will automatically format your data with a nice heading and center 

and add some lines between the data itself.  

 

So go ahead and choose an option.  I‟m going to choose this blue option here.  It says, “Where 

is the data for the table” - is already entered because I had selected the data with my mouse 

beforehand.  And I want to indicate that my table has headers, which are individual beak size, 

sex and survive.  Click OK, and that formatting is automatically applied.  

 

What‟s often done is you want to summarize your data and create some statistics about it.  And 

in other words gather some outputs, some output values, as a way for you to talk about the 

results of your particular model.  And, yes, this is a model.  This is a model that shows how 

populations would change over time, who‟s going to live and who‟s going to die, based on these 

entries that we have made in the input boxes here.  

 

And so now, what would be nice to do is to go ahead and have a section for outputs.  In cell I1, 

let‟s type the word “Outputs.”  And let‟s start off by doing some very simple kinds of calculations 

using some formulas and functions in Excel that are very, very commonly used.  

 

Let‟s start off by counting the number of males.  And so we‟ll enter that in cell I2.  And I want to 

go ahead and make this column auto-sized, and I do that by double-clicking on it.  And let‟s go 

ahead, also, and count the number of females. And, again, I can double-click it to auto-size that.  
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These are my outputs, and I‟m going to calculate them. I‟m going to enter a formula in cells J2 

and J3.  And what we‟re going to do is shade those a different color.  I‟m going to choose a 

blue, and that would indicate that those are model outputs. These are things that would be 

calculated automatically for us as we change these input values.  

 

One of the most common functions we can use is called the “Count If” function.  And what we 

want to do in cell J2 is enter an equation that‟s going to count how many of these individuals are 

males.  So let‟s find the Count If function.  I‟m going to go to the Insert Function dialog box.  And 

if I don‟t know where to find this, but I know the name of the function - once again, choose All, 

and then type in the first letter of the function name „C‟.  That‟ll drop you down to all the 

functions that begin with the letter C.  And then scroll down until you find Count If.  There it is.   

It counts the number of cells within a range that meet the given condition.  We click OK, and the 

dialog box appears.  

 

And this particular function has two arguments. The first thing we need to tell the spreadsheet 

is, “Well, what is the range of cells we want to evaluate”?  And we‟re going to use our mouse 

and select cells C5 through C29.  

 

Now what you‟ll notice here is that when we created this table, Excel took this column and 

called it Table 1, and it labeled the column here in brackets.  And that‟s fine.  That does the job 

that we need it to do.  And our criteria is we want to count the number of males, and those are 

cells that have the letter „M‟ in them.  And the result is given, and you click OK.  And that is a 

model output. 

 

Now, remember, I still have random numbers here. So my beak sizes are always changing. So 

if I press F9, my outputs will change because I‟m gathering a brand new population of birds, 

assigning them a sex, male or female, and then letting them live or die, according to the survival 

threshold.  

 

See if you can enter a formula in cell J3 and count the number of females.  

 

We‟re going to use the Insert function. In this case, I can choose the Most Recently Used 

category because I just used that “Count if” function, and I click OK.  And my range, again, is 

going to be the same.  And the criteria this time is I want to count those cells that have the letter 

„F‟ in them.  And notice that this is not case sensitive. It‟s still counting the number of females, 

even though they‟re entered in the actual data table itself as an upper-cased F. 
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Some more outputs that we might want to consider is getting a handle on what the range of 

beak sizes are in the population.  So we‟re going to use two common functions „Min and Max‟. 

Enter those words in cells I4 and I5.  And then in cell J4, we‟re going to enter an equation that 

tells us the minimum beak size.  And that‟s just the function M-I-N.  

 

We can find that, again, by going in - if we don‟t know what it‟s called, we can just type in a brief 

description, Minimum, click Go, and Excel pops up things that might be of interest to you.  And 

you can click on them until you find the one you want.  

 

And this particular function has an argument. You can enter these numbers one at a time, 

numbers 1, 2, 3, all the way through 25. Or, instead, just enter all of the cells that you want to 

examine in the first argument box.  So we‟re going to go ahead and select cells B5, the beak 

size, and that‟s all we need to do.  We don‟t need to enter a second argument because all of the 

animals are contained within this particular column.  And we click OK, and that reveals the 

minimum beak size.  

 

The maximum‟s very similar, and in fact, what I can do - the maximum is just M-A-X.  I can copy 

this formula, select the formula with my mouse and then go Copy.  And then I can come down -

press Enter so you don‟t mess up your formula there - and I can choose inside the formula box 

and paste that in.  So it‟s exact same reference.  And now what I can do is just change this to 

Max, and that provides the maximum number.  Just a shortcut way - once you begin to know the 

names of these functions, you‟ll probably start to use a lot more shortcuts than using the dialog 

boxes themselves.  

 

Okay. Two other common outputs are to assess the average beak size and the standard 

deviation of the beak size.  And so we‟re going to do those and calculate those in cells J6 and 

J7.  In J6, we‟re just going to use an Average function, which in Excel, is just called „Average‟. 

But let‟s see if we can find it a different way.  

 

This is a statistical function.  And if you click on Statistical, all the different kinds of statistical 

functions appear, and we find it as second on the list.  And here, again, we just need to enter 

our data range, and then press OK.  

 

The next one we want to find is Standard Deviation. In this case, let‟s go up to the Formulas 

tab, and then let‟s find statistical functions.  And in this particular case, we‟re going to find the 

standard deviation, so use the scroll bar and scroll down until you find S-T-D-E-V.  This 
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estimates the standard deviation based on the sample size.  Shrink the dialog box up, select 

your data, expand the dialog box and press OK.  

 

Now all of these are outputs, and so I want to shade those the same colors I‟ve been using back 

in my Home tab so that it‟s quickly and easily - you‟re easily able to find what are your outputs, 

and what are your inputs. You might also choose to merge those cells for outputs, as we did 

before, with the Merge & Center button.  We can make that bold.  And some people like to 

select their particular thing and put a big, fat box around them, a thick-border box to make sure 

that that‟s offset like some kind of a control panel.  

 

If we want to clean up our data a little bit more, we can select columns A, B, C and D, and we 

can center them, left-align them, right-align them, and we can change where the position of the 

numbers are within the particular box itself.  

 

Let‟s assume you want to know what a particular individual is doing and whether that individual 

survived or not . Let‟s enter the words “Lookup individual” in cell F4, and let‟s let that be an 

entry.  And let‟s say, for example, that you wanted to know what Individual ten‟s fate was.  And 

so this is a model input, and so we‟re going to color it the same color green, that we had before 

and make it match the borders.  We‟re going to look up Individual ten, and we‟re going to find 

out did that individual survive or not?  So, basically, what we‟re doing is finding number ten in 

this particular table and then scrolling all the way over and then recording what‟s in cell D14 that 

goes with it.  

 

We‟re going to use another kind of function, and this is called a Lookup function.  And Excel 

has three or four different kinds of Lookup functions, and they‟re really handy functions for a 

number of modeling purposes.  

 

In this case, we‟re going to use the one called V Lookup, where V is for vertical.  And what that 

means is you‟re going to - your data are aligned vertically, and you want to look up the number 

ten in the first column of a data, where the number is appearing some place in the first column.  

 

And then the second argument of that particular function is going to be, to tell Excel, “What 

column do you want to return the data with? Do you want to return its beak size?  Do you want 

to return its sex?  Do you want to return whether it survived or not”?  

 

So let‟s see how that function works. So let‟s type, in cell I8, “Lookup Result.”  This is an output. 

And in cell J8, we‟re going to use the Lookup function, V Lookup.  And let‟s go ahead and go up 
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to the Formulas tab and choose the Lookup & Reference option and use and find V Lookup, 

which is way down at the bottom.  

 

It says here that there are four arguments, four pieces of information that that function needs in 

order to provide a result. The first - click in the box - is you need to tell what value to lookup. 

Well we‟re going to lookup whatever value‟s in cell G4.  

 

Then the second argument is tell the spreadsheet, “Where‟s the table that you‟re going to be 

looking up this information in”?  And this number, whatever we‟re looking up, needs to be in the 

left-most column. So we‟re going to choose all of this data here, Table 1.  That‟s because we 

applied this formatting to these tables here.  

 

The Column Index indicates, “What column do you want Excel to return the information”?  And 

in this case, we want to return whether that individual survived or not.  So that‟s column 1, 2, 3, 

4.  And so we‟ll enter the number 4 as that particular argument.  

 

Now you‟ll note, if you look in these - get in the habit of reading the information on the dialog 

box.  What this says is this lookup, V Lookup, looks for a value in the left-most column of a table 

and returns a value in the same row from a column you specify. By default, the table must be 

sorted in ascending order.  And ours is, because our individuals go from numbers 1 to 25.  

 

And what we can do here in the last argument for the Range Lookup - this is not bold - and so 

it‟s not a required argument.  But what this particular argument does is if you need to find the 

exact same match, you need to enter the word “False.”  And so we‟ll do that because we want 

to find the exact same match.  

 

These functions can use lookup values that are close, close enough in a particular order, and 

they become handy.  Using the word True is handy in some instances. We may see that later on 

in the course.  

 

Once you have your equation entered, just press OK, and we find that Individual ten did not 

survive.  This is an output, and so by convention, let‟s go ahead and shade that the same way 

we‟ve shaded our other output boxes - and there we go.  

 

Now one thing that you will find that is very useful to do to summarize your data in a frequency 

graph, or frequency chart.  This is just a depiction of the raw data and it‟s perhaps one of the 

best tools to summarize your data to show a reader or a viewer what you‟re data look like.  It‟s a 
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graphical depiction.  And so, we‟re going to use a function called “Frequency”.  And it‟s a 

different kind of function it‟s called an „Array‟ function.  And let‟s show you how that works. 

 

To do that we‟re going to start by entering in cell F7, the word „Bins„.  And I like to think of bins 

as a bucket.  And then in cell G7 lets enter the word „Frequency‟.  Okay, so what we‟re going to 

do here is start - and say well what kind of buckets do I want, or bins do I want, to summarize 

my data as? 

 

And so lets go ahead and start by entering the number 1 in cell F8, and then 2.  Then lets go 

ahead and take that series, select both cells in our series and then drag the corner of the handle 

down until we hit the number 10.  And these are our bins, or buckets.  And so what we‟re going 

to do is count how many birds have a beak size that is between 0 and 1.  And we‟re going to 

record that number there [Frequency column]. 

 

How many birds have a beak size that is between 1 and 2?  And that would be recorded in cell 

G9, and so on.  And so we‟re going from bucket to bucket, or bin to bin, and this number 

represents the uppermost value of that particular bin.   

 

Now to enter a function like the frequency function, you enter it differently than just hitting the 

insert function key.  This is called an „Array‟ function.  And so we‟re going to enter this same 

formula across multiple cells at once.  And so you need to begin by selecting all of the cells that 

this formula will pertain to.  So lets go ahead and do that.   

 

Select those cells G 8 through G17.  Now lets go up to our insert function key or command.  

And we‟re going to be looking for the Frequency function.  So I‟m going to All and then I‟m going 

to type the letter „F‟ and then scroll down until I find Frequency.  So Frequency contains two 

arguments.  The first argument is the data_array and the second is the bins_array.  So we found 

the function, lets click OK. 

 

And our first argument is, where are the data that you want evaluated.  So lets shrink the dialog 

box up and then lets simply go ahead and select, in this case lets select, the beak sizes.  So 

we‟re going to drag all of our column all the way down from B5 to B29.  And then lets expand 

the dialog box once again.  

 

The next argument says well, where are the bins or buckets that you‟d like to put and 

summarize the data into groups or groupings - or ever how you would like to call that.  So our 

bins array are going to be cell F8 through F17. 
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IMPORTANT:  Now it might be very tempting for you to press this button [OK], and I wish that it 

wasn‟t there, because when you press this button „OK‟ you are going to get an error.  And lets 

go ahead and press this right now, and you‟ll see that this equation was only applied to the first 

bin.  And we don‟t want that to happen.  

 

So lets go back.  I‟m going to delete this, and lets go back, and we‟ll select all of them at the 

same time.  Find our Frequency button once again.  Now I‟m going to choose „Most Recently 

Used‟.  Again our data array consists of all the beak sizes.  And our bins array are bins 1 

through 10.  And now instead of pressing OK, I want to calculate this across the entire array.  

So you do that by pressing CTRL SHIFT and then Enter.  And then you can tell that it‟s an Array 

function because the formula has these curly brackets around them.  And the entire Array 

function has been completed across all of the bins at the same time. 

 

Array functions are a really handy tool.  And we‟ll use those occasionally in the class.  The most 

commonly used formula that we will be using is the Frequency formula. 

 

This means that one animal had a beak size between 0 and 1.  Four animals had beak sizes 

between 1 and 2 and so on.  And, of course, you‟re numbers will look different than this 

because these numbers, these beak sizes, are all generated with random numbers.   

 

The next thing to do is to graph this.  And so lets go ahead into the Inset tab and we‟re going to 

go ahead and insert a column chart.  And we can just choose the column chart to begin with.  

What I like to do is go ahead and select the data before I choose this option, because then the  

program knows already what you‟re talking about.  So it went ahead and graphed out the bins 

which we don‟t need to depict, as well as the frequency.  And so let‟s scootch this over a little 

bit, and we can eliminate the bins series of data by just clicking on that series and pressing the 

delete button.    

 

Now remember when you have a chart embedded within your spreadsheet a whole new set - a 

part of the ribbon - is created.  And, in this case, it is the section here called „Chart Tools‟ and 

there are three tabs.   

 

If we choose the Layout tab with our chart still selected we can now go and add a title, as well 

as some axes.  So lets go ahead and add some axes.  If we start with the Primary or Horizontal 

axis, and choose title below axis, we can label the title here, „Beak Sizes‟.  And it is inserted 

down below.  We‟ll click the chart once again, and now lets go ahead and add the Vertical axis.  

And lets go ahead and choose the Rotated Title option.  And then we‟ll type in the word 
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„Frequency‟.  Press enter or the checkmark and Frequency is added.  We don‟t really need to 

display this portion, so we can select it and delete it.  And our graph looks a little bit nicer. 

 

So that is the Frequency function.  And this gives you a very nice graphical display of your raw 

data.  And I think that these frequency graphs are perhaps one of the most under used tools 

that we have in science and modeling.  They give you a complete description of your full range 

of data pictorially.  

 

Now there are two more functions that I‟d like to introduce you to.  And these are functions that 

are used later on in the course, and those are the And and the Or operators.  And if we look at 

those - just go to the Formulas tab, and those are called „Logical‟ functions.  If you click on 

them, there‟s And, and there‟s Or.  And both of these contain arguments that are evaluated, and 

the answer is either true or false.  

 

And what we‟re going to do now is we‟re going to go through a few different cases of how we let 

animals survive.  The case that we have right now, the formula we have right now is, if the beak 

size is greater than the survival threshold, it survives. Otherwise, it dies.  

 

What I‟d like to do is to take a few minutes just to demonstrate how you can combine different 

kinds of criteria, which will end up being useful tools for you later on in the course when you‟re 

doing some different kinds of modeling.  Let‟s see if you can wipe out the formula in cells D5 to 

D30.  Just push the Delete key.  So our frequencies won‟t be affected because we still have 

beak sizes here.  

 

Let‟s change, though, how those animals survive.  And let‟s write an equation in cell D5 that lets 

all the females survive.  Going to be another If function. I‟m going to choose the If function.  And 

I‟m going to ask - I‟m entering an equation in the same row for Individual one.  Is Individual one 

equal to a female?  If yes, the female survives.  If no, it‟s a male, and they die.  

 

Notice, again, this funny syntax right here is because we called this a particular table, and we 

named it.  If that bothers you, don‟t use that table trick that we did earlier in the exercise. 

  

We click OK.  And now we can just copy this formula down, and we have a set of survivals 

where every female is surviving, and every male is dying.  And you can switch those if you‟d 

prefer, as well.  
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Now let‟s try a case, though, where we want the survivors to be large animals that have a beak 

size of greater than 0.5, or are males.  So either one of those conditions will result in a surviving 

animal.  And so to do that, we‟re going to use an Or function.  So let‟s clear out the entries in 

column D.  

 

And we‟re going to start this - this is going to be a Nested function because we need to evaluate 

two things.  We need an If function, and we need to have our logical test, though, contain two 

kinds of criteria rather than one.  And, again, this is called a „Nested‟ function.  

 

So let‟s start off here again. We‟re going to use the If formula.  And our logical test now is going 

to include another Excel formula, called the „Or‟ function.  And we can do that by just typing it in 

directly into the first argument box here.  

 

And if you need help with that particular function, you can click inside there, and then go up to 

the Name box, and you‟ll see this is now not referencing a cell.  It‟s referencing formulas.  And 

you can see if your Or function appears within that particular list.  If it doesn‟t, select More 

Functions, and then find Or, click OK.  And now what it‟s done is it‟s inserted an Or function, 

which has the green parentheses on the video here.  

 

And now I can say, If the animal - so if the animal - the beak size is greater than the threshold 

survival, that‟s one possibility.  Or, now the other possibility that could happen is that the sex 

could equal male.  

 

So the Or argument is going to return - it‟s going to look at this logical test number 1, and it‟s 

going to evaluate it.  Is it true or false?  Then it‟s going to go to logical test 2 and evaluate that, 

true or false.  So, in our case, it‟s looking at animal one.  It‟s asking, “Is its beak size greater 

than our threshold, or is it a male”?  And in this particular example, it‟s a male.  So it‟s true, but 

it‟s smaller than the threshold, and so the first argument is false.  

 

This function checks to see whether any of the arguments are true, and it returns a true if any of 

them are true.  And it returns a false if all of them are false. So we can press OK.  

 

And it gives me an error.  And the reason it‟s giving me an error is because it‟s not telling me I 

made a error in my Or function; it‟s because I made an error in not finishing my If function.  So 

go ahead and press OK.  

 

And now we want to finish off our If function. So put your cursor right on the word If and press 
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the FX box again.  And you can see, then, that now our long Or function has been written into 

the logical test.  And it says, “If any of these conditions are true, then it‟s going to survive; 

otherwise, it will die.”  And press OK.  And now our formula is filled down, and we now have a 

condition in which either males will survive or large animals will survive.  

 

The other function‟s very similar to the Or function, and that‟s called the „And‟ function.  And, as 

you can imagine, it‟s going to take a number of arguments.  And every single one of those 

arguments must be true in order for the function to return the word True.  

 

So let‟s go up to our Insert function.  Again, it‟s going to be an If function.  And let‟s make up a 

scenario now where the beak size needs to be large, and it has to be a female.  If, now let‟s go 

back up and find And.  There it is.  And now this one, same kind of syntax, but now every single 

one of these must be true in order to return the word True.  If any of them are false, then the 

formula result will be false.  

 

So our first test is, “Is the beak size greater than the threshold”?  And our second test is whether 

the animal is a female.  Press OK.  I‟m going to get that error button again, and that‟s okay. That 

error‟s about my If.  I‟m going to click on If and open up the dialog box again. So now it says, “If 

the animal has a large beak, and it‟s female, then it survives; otherwise, it dies.”  Click OK.  And 

it actually auto-filled that all the way down through the table itself.  

 

So those are the And and Or functions.  And they‟re handy tools for you to have in your model-

building toolkit. 

 

I want to show you one more kind of tool that we‟ll be using in spreadsheet modeling that we‟ll 

probably use quite frequently in this course, and that is using a spreadsheet macro.  And a 

macro is just a simple set of instructions that the computer does, and it reads through those 

instructions and so that when you press a button and run a macro, it will follow those 

instructions faithfully and carry out a particular task.  And what you are going to do, as a 

developer, is tell the computer what those particular tasks are.  

 

And so what we‟re going to do is develop a little macro that‟s going to clear out these random 

numbers and draw a new set of random numbers and paste the values right on top of that.  And 

so that this is a fixed population rather than a bunch of random numbers now.  And that‟s about 

as simple of a macro as we can have.  And I just want to show you how you go about making a 

very simple little macro. 
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Now the first thing you may want to do is go up to the Office Button and click on it.  And then 

choose the Excel Options tab.  And then under the Popular page, select the option Show 

Developer tab in the Ribbon, and then press OK.  And that puts a new tab right here called the 

Developer tab.  

 

If we click on that, you‟ll see that you can get into some Visual Basic Code, you can choose 

these buttons to record a new macro or to view your previously written macros. This is the 

Relative Reference button, a very handy button, which we won‟t be using right now but, 

perhaps, in the future.  And then these are different ways for you to start looking at your code 

and things like that, which we‟ll do a little bit of in this course, not too much. 

 

Now to record a new macro, you simply select this button [Record Macro], which records a 

macro.  And give it a name.  And we‟re going to call this macro „GenerateBeaks‟.  And you can 

assign it a shortcut key, such as Control G, or pick any letter you‟d like.  

 

And you‟re going to store this macro in this particular workbook, which is fine. You have options 

of storing them in other workbooks and linking macros from workbook to workbook, which lets 

you use macros across different sheets if you would like to.  

 

And then, finally, enter a short description.  This macro will generate beak sizes for 25 birds 

randomly.  And we click OK.  And now we are recording.  Every single key stroke that we make 

is being recorded and written into the program in Visual Basic Programming.  Don‟t click on that 

button.  So any key strokes, any mouse strokes, any clicks that I do, they‟re being recorded, 

faithfully, by the program until I press the Stop Recording button.  

 

So the first thing we‟re going to do in this particular program is we‟re going to just replace this 

formula with the actual same formula itself.  We‟re going to enter a random number, and we‟re 

going to multiply it by 10, and we‟re going to copy that formula all the way down.  Okay.  So I‟m 

just doing exactly what we‟ve always had here.  

 

And what I want to do next is then select those cells once more, right-click, and now I can use 

some other kinds of shortcuts that are available.  I can copy those and select those cells one 

more time, right-click again, and then choose the Paste Special option and paste the values in. 

And click OK.  So what we‟ve done, is we‟ve generated random numbers in this particular set of 

cells, and then we‟ve replaced those random numbers with a fixed value.  So there‟s no longer a 

function in those cells.  They‟re the actual number.  
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Now that you‟re done recording, you can go up to the Stop Recording button and press that. 

And now you have a function that will generate new random numbers.  It‟s called a macro.  And 

you can find that macro by clicking on the View Macros button or pressing the Alt and the F8 

key.  

 

This particular macro - I made an old macro called NewBeaks.  This one we called 

GenerateBeaks.  And if I click it, and I say Run, that particular program will execute the steps 

that we just recorded.  It‟s going to generate a new set of random numbers.  

 

Let me show you, if you click on the Edit, this brings up the Visual Basic Code that was used, 

and I‟m going to want you to focus in on this portion. This is what was actually recorded.  The 

code itself, that is written in Visual Basic, it‟s Visual Basic for applications because it runs within 

an application, in this case, Excel.  

 

And the information that is color-coded in green, which starts with an apostrophe are called 

„Comments‟.  And those aren‟t read by the program, but they‟re there to help you understand 

what this macro was.  So here‟s where I entered the description, and this is the name of the 

macro.  And here is that macro shortcut key. And we‟ll play with this in just a second.  

 

This is the actual Visual Basic Code. The code itself begins with the word Sub, and it runs this 

sub-routine called GenerateBeaks.  And then it ends with words End Sub.  And then here are 

the series of mouse clicks that we used.  So we started with cell B5.  We entered the formula, 

“Equals random number times 10.”  We selected B5.  Then we filled down to cell B28.  Then we 

selected the range of cells, and we copied it.  I actually did it twice because I didn‟t - so there‟s 

two lines of code there.  And if you have a duplicate line, you can edit this freely by just 

eliminating some of the lines of text.  And then we selected that again, and we pasted in those 

particular values and stopped.  

 

So I‟m going to go up and close this now. It‟s going to look like I‟m closing out of the Excel 

program.  I‟m not.  I‟m closing out of the Visual Basic Editor.  So I‟m going to close it. It brings us 

back to our spreadsheet.  And now if I use my Control G shortcut, it will run that particular macro 

again.  

 

So what it‟s doing is creating - populating this list of cells with random numbers.  And then it‟s 

replacing them with a value rather than the random number.  And you can actually see - look at 

the formula bar - how it‟s actually stepping through the macro itself.  
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So macros are a pretty handy way - and we‟re going to use those a lot in this class.  They‟re a 

really, really important tool for doing some different kinds of modeling.  

 

Now there‟s a couple ways - if you‟re like me, you‟ll always forget what your shortcut keys are. 

And so there‟s a few ways you can quickly assign a button or a picture to run the macro for you.  

 

So if you click on the Insert tab on the Ribbon, and we insert - let‟s just pick a shape.  Go to the 

shapes thing and find a nice shape that you like and stick it some place on your page.  I‟m going 

to go ahead and put mine right there.  And now if I right-click on that shape, I can assign a 

macro to that particular shape.  And that macro we want it to run is called GenerateBeaks. 

Press OK.  And now if I press the smiley face, that particular macro will run.  

 

The other way you can do it, is you can actually make your spreadsheet look more like a form. 

And you can add a button to your mini tab up at the top here.  And I‟ll just show you how I did 

that.  We‟re going to click on the Customize Quick Access Toolbar.  And we want to show more 

of the commands so that you can see what is actually being displayed.  

 

What I have on my toolbar is called a Button, which is a form control.  And you can find that by 

clicking on the All Commands button, and this will list every single kind of button that you can 

pop up in your mini toolbar.  So if we find the Button, and there it is, it‟s a form control. Click 

that, and then choose Add, and that‟s how I got my Button to be located on my mini toolbar.  If 

you like to really customize your spreadsheet, this is a good way to do that.  

 

So after you have it over and added to your document, press OK.  And the button will appear up 

on your mini toolbar.  Now you can click it, go anywhere in your spreadsheet, and click on the 

button.  And you can tell the button that when you click that button, it‟s going to run the macro 

GenerateBeaks, and you press OK.  And you can re-size the button if you‟d like, and you can 

also select the words and type in a new word and call it, you know, NewBeaks or whatever it is 

you want to do.  And now when you press that, it will run that macro as well. Okay.  

 

We‟ll be learning some more shortcuts and options as we go through different exercises.  We‟ve 

covered a lot of ground here.  But the goal of this particular exercise was to demonstrate and to 

show you some of the most commonly used features that we‟ll be using throughout this course.  

 

Remember, you can always go back and review this particular video.  
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And I would encourage you to develop this spreadsheet completely on your own.  And I‟d also 

strongly encourage you to go ahead and try and take some time and click around and see what 

different options are available to you.  And to not be afraid to try out new things and explore 

because you‟ll never know what might pop up.  And there are an awful lot of things that we 

didn‟t cover in this particular exercise.  

 

Okay. That‟s it for now, and thanks for watching.  

 

 < 01:23:42  END > 


